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Mechanical Operation of the Micro-Image Capture 7 

Lens Rough Focus Dial – Turn to bring image into initial focus 

 

Zoom & Fine Focus Dial (large) and Fixing Knob (small) 

  
Adjust Zoom Dial to get image to the approximate size desired while 
in Full Screen Mode, and then find initial focus using rough focus 
dial on lens. Once focus is close to optimum, use the large Zoom Dial 
again to fine focus the image even more. This lift mechanism is a 
precision scientific mechanical device that is designed to move 
gradually. Take care not to turn too fast, as damage may occur. 
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Glass Lift Plate – Curved Metal at back of glass (silver) 

        
Bring the Fiche Carrier to the front of and the auto glass lift feature will 
open the fiche carrier to insert the microfiche. Flip or rotate fiche until 
orientation is correct on-screen. 
Power Switch – Turns the illumination lamp on/off 

Turn on to view microfilm images and turn 
off when not in use to extend light panel life. 

 

 

The MIC7 comes with a 7-54x 
magnification scale, (longer mast than 
pictured) and requires the head lift 
mechanism to be secured at the very top 
of the mast to achieve magnifications 
from 7X to 32X and at lower mast to 
achieve magnifications from 32X to 54X.  

The mast on MIC7 is scribed for easy 
visual indication of correct upper and 
lower mechanism positions. 
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Micro-Image Capture 7                                     
Minimum system requirements 

• Processor: Pentium P4 2.4GHz or equivalent AMD Athlon (Duo Core is best) 

• 140 MB free HD space for view and capture programs 

• Operating System: Microsoft Windows XP, Vista, W7/W8 or MAC O/S X V10.3 

or higher. USB 2.0 (enhanced USB) is required for optimum performance  

• RAM memory: 512 MB RAM – Recommend 1GB or more & USB 2.0 or 3.0 

• 16-bit color display w/ DirectX 3D support (works with 32 and 64 bit as well) 

• DirectX 9.0 or above 

*High Resolution LCD Monitor capable of 1024 x 768 at a minimum (higher is 

better), and with sufficient height and width to display microfilmed image at 

its original size. A graphics card providing high resolution streaming video with 

matched monitor will provide the best very best image viewing and capture quality.  

Visit our YouTube channel on monitor requirements >> http://youtu.be/-FLci3fqLY8  

To view and capture these Portrait and Landscape microfilm images at optimum 

resolution, your monitor view area must be at least 8.5” high and 11” wide for 

landscape images and 11” high minimum for portrait (letter size originals on film). 

 

 

      Portrait                                         Landscape 

Engineering applications (11x17” originals or larger) require min 24” wide screen 

Snagit System Requirements 

• Microsoft Windows XP with SP2 (32-bit only); Vista, Windows 7, or 
Windows 8 (32-bit and 64-bit) installed and configured on your system  

• Internet Explorer 8.0 or later required  

• .NET 4.0 or later required for video  

• 2.4 GHz single core processor (2.4 GHz dual core required for video)  

• 1 GB of RAM (2 GB required for video)  

• 125 MB of free hard disk space  

• Video capture on Windows 7 requires Windows 7 supported video and audio 
hardware  
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Software Installation & Adjustments 
** Please do not connect the Micro-Image Capture USB cable to your PC until 
AFTER the software and drivers are fully installed. Doing so may prevent the 
drivers from fully installing and the unit may not operate properly. 

Be sure to temporarily disable firewall, anti-virus or network security software to 
ensure proper installation of Micro-Image Capture drivers and Snagit Software. 

1. Install Micro-Image Capture Drivers / User Interface Disc 

2. Install Snagit Software Disc (Note software key on label) 

3. Install USB Footswitch Software 

Next, view the USB Footswitch tutorial video on our YouTube channel and set the 
footswitch to F10.  (You will also set the Snagit hotkey to F10) 

http://youtu.be/4uPugBuD2C0  

Now, view the Snagit tutorial videos to configure Snagit for your particular 
application (Print, Save to File or both) 

Micro-Image Capture Tutorial - Create Snagit save to .tiff profile w- Wizard 

http://youtu.be/9yoI4opK47w  

Micro-Image Capture Tutorial - How to configure Snagit to print images 

http://youtu.be/3fib-8-TpmU  

See other YouTube tutorials for advanced functions like fixed region capture and more. 

Configure hands free fixed region capture >>http://youtu.be/NuVlzuAXYds  

How to automate brightness/contrast enhancements >>http://youtu.be/dvqlGglIh90  

How to  add a watermark to printed/saved image >> http://youtu.be/Zx2AhzRh-0c  
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Micro-Image Capture Software – Quick Start Guide 

Follow these instructions or view our YouTube Tutorial  

Micro-Image Capture Initial Adjustments > http://youtu.be/gM0KlhAJ9XA  
There are three main tabs in the MIC user interface; Video, Image and OCR. The Video tab is 
where you will adjust images prior to view and capture in full screen mode. 

 You may use the Micro-Image Capture Software to capture images but we strongly 
recommend using Snagit instead as it offers increased functionality, speed and ease of use. 

 If you do capture images with the MIC User Interface instead of Snagit, the Image tab is where 
post scan images can be adjusted, printed, faxed, e-mailed and OCR’d if desired. The OCR tab 
will open up the OCR’d document(s) when complete, for review and saving.  A mouse with a 
scroll wheel provides optimum usability when using the MIC user interface. 

1. Load the Micro-Image Capture software; plug in the USB cable to an available 
USB 2.0 or 3.0 port, then click the Micro-Image Capture launch icon.  

 

2. Click on the Video tab to activate the Micro-Image Capture unit and display a video 
image of your microfilm. 
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3. The default mode is color, but Grey Scale, Black Line and Color Inverse modes are more 
suitable for viewing and capturing microfilm images on most film media. Now click the 
Grey Scale option to remove color from the image. * You may need to slide the 
“saturation” slider up and down to fully remove the color  * 

4. The image will probably be out of focus initially, so raise or lower the MIC head unit 
using the large black knob on the side of the unit until you see some sort of image, even if 
out of focus. We will first concentrate on getting image settings correct, and then focus. 

5. Adjust the image quality by un-selecting the auto exposure box and manually adjust the 
exposure to provide a viewable base line exposure with brightness set at zero. 

6. Adjust the brightness and contrast in order to achieve the most legible image in the grey 
scale mode. Dark portions of your image should be as black as possible while light 
portions should be white, not gray. Contrast normally is best set at 20. 

7. Adjust Gamma to remove excess gray in the background of the image in order to achieve 
a best possible contrast. Gamma seems to provide best results at 100. 

8. If you are viewing negative film, you may now try the”Inverse mode” in order to see the 
image with a more natural white background and grey/black text (aka positive mode) 

9. When switching from “Grayscale” to “Inverse mode”, you may need to re-adjust the 
brightness setting in order to achieve the best view and scan result in that mode. 

10.  If you have high quality film with very good film density and contrast, the “Black Line” 
mode will provide an excellent negative image to view and print with, but you will have 
to program Snagit to invert the output color by choosing “Color Substitution”, then 
“Invert Colors” so that your output print and scan will be positive. More on this in the 
Snagit adjustment section. 

11. Using the scroll wheel on your mouse will enlarge and reduce the onscreen image of your 
microfilm while in the user interface mode only. Use the camera lift mechanism while 
in the MIC “full screen” mode to optically zoom the image on your pc screen so that 
it is as large on your monitor as the original document was for best viewing and 
scan/print results.  
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Full Screen Mode 

We strongly recommend using “Snagit” to capture and send images to a network printer or 
folder. The “Full Screen” mode is how you will effectively view your images at full size in 
order to achieve the very best on-screen image, as well as the best digital scan and/or print.   

Click the “Full Screen” icon on the MIC toolbar. 

The Full Screen Mode allows for a much larger image to be displayed since the user interface 
tool bars are not in view. You can capture images by activating the Snagit function hot key (See 
Snagit installation instructions), or mouse over the lower image area to activate the scan button 
using the Micro-Image Capture program (we however recommend using Snagit exclusively).  

Zoom and focus the image so that the displayed microfilm image is as close to its full original 
size as possible. In order to view and capture images at optimum resolution, it is important that 
you have a quality LCD monitor with sufficient vertical and horizontal area to allow the image to 
be zoomed to its original letter (8.5x11”) or legal size (8.5x14”). (Engineering applications 
should use a large format monitor). Hold a blank 8.5 x 11” paper to the screen and try and make 
the image that size. If you monitor does not have sufficient view area, you may need another. 

Click escape key or mouse over the lower middle of the full screen mode 
and click “Exit Full Screen” to go back to the standard view mode.  
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User Interface - Video Tool Bar Icons & Descriptions 

  Clicking the scan button will capture the complete viewable screen.  (Use the 
“rectangle select” to designate a smaller capture area) *Use Snagit to capture scan images 

 Clicking the record button will record a video file of the movements made with the 
microform until you click again to end the video. This option can be used to create a presentation 
of microform content. *Use Snagit to capture video 

  Clicking this icon will activate the color inverse mode changing a negative grayscale 
image into a standard black on white image which may be easier to view for some and saves on 
toner consumption if printing. 

 Clicking this icon will activate the grey scale mode removing color from the image 
and displaying in shades of grey only. 

 Clicking this icon activates the black line mode with can provide excellent contrast 
on some microfilmed images. Use in conjunction with the “Color Substitution” in Snagit. 

  Click this icon and use your mouse to drag a capture box onto the image display. 
When active, the capture area will be brighter than the non capture areas. When clicking scan, 
only the capture box will be printed or saved. *Use Snagit to capture images 

  Full screen mode allows for optimal image size and removes the user interface 
tools. This is the recommended mode to view, capture and print images using Snagit 
hotkey. 
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  Click to bring image back to original size after zooming or reducing with mouse 
wheel. 

  The clear button will clear the previous change made and continuing to clear will 
revert back one step at a time. 

  Click the move button to use the mouse to position or nudge the image onscreen. 

  Rotates the image 90 degrees clockwise 

  Rotates the image 90 degrees counter clockwise 

  Vertically flips or mirrors the image 

  Horizontally flips or mirrors the image 

 

  If you are using the MIC interface to scan and capture images instead 
of the “Snagit” software, thumbnails of images scanned will appear on 
the left side scan result area. Clicking on an image thumbnail will open 
the image in the Image Tab and clicking on “File Location” at the 
bottom will open the image destination folder for review or selection of 
images for printing or other actions. 

Once you have achieved an acceptable image for viewing, scanning and 
printing, record the video property settings (brightness, contrast, hue, 
saturation, sharpness, gamma and exposure) so that you have a future 
reference that will allow for quick and easy adjustment in the future.  

*Use Snagit to capture images, it is faster, only one click! 
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The MIC user interface will remember most of the last used adjustment settings when the system 
is closed and re-opened, but you may have several formats of microfilm that require different 
settings for optimal performance, note these settings and keep them close to the MIC system for 
reference. 

Video Resolution 

     

Video resolution is optimum at 2592x1944 (5MP). Adjusting to the next setting down 
2048x1536 (3MP) will provide a faster refresh rate (less image latency) and almost the same 
scan / print result so try that setting if you prefer a faster refresh rate when searching for 
images.  Insure the MIC unit is connected to a USB 2.0 or 3.0 port and not USB 1.1!  USB 
1.1 will cause the MIC unit’s video stream to work slower than normal. 

After image is located, the Video Resolution can be maximized with the slider in an instant.  

All digital microform viewer/scanners have a measure of image latency which can take a little 
getting used to as compared to traditional reader printers that bounce images of mirrors for real 
time movement. After several uses you will become accustomed to the operation of the unit. 
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Snagit Capture Software 
Using Snagit to capture displayed Microfilm Images 

If you have already installed Snagit software and viewed our YouTube tutorial videos, the 
following information is for reference. 

 

Snagit allows you to capture anything you see on your computer screen.  

You will use Snagit to capture your displayed microfilm images instantly converting them to the 
file of your choice (tiff, pdf, jpg, etc.) and within a second or so, dropping them to the file folder 
of your choice, sending them to your printer or both simultaneously! 

 Snagit has a lot of functionality which can be utilized for many other applications, but for our 
purposes, we will concentrate on how to configure Snagit to quickly and effectively print and 
save your microfilm images. 

Snagit is an essential part of the Micro-Image Capture 2 & 5 systems, and its ability to capture, 
scan, print images. 

 It is therefore critical that you read the next section carefully and follow the directions step 
by step to insure proper operation of your system. Once you get familiar with Snagit and 
its capabilities, you will be able to realize optimal performance from your new Micro-
Image Capture device. 

If you require assistance or have any questions about the installation process, please call your 
Micro-Image Capture dealer. 

Once Snagit is installed and properly configured, you will be able to press a function key on your 
keyboard (hot key) and instantly capture the displayed microform image, sending it to a file 
folder as a .tiff, .pdf or other format, to your network printer or both in a second or two. If you 
cannot achieve this level functionality, call for assistance. 

Load Snagit Software disc into the host PC’s CD/DVD drive and install. Unlock code is printed 
on the DISC label. 

Click the Snagit icon    on desktop to launch the Snagit Control Panel.  
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The Snagit Control Panel 

 

 

You will be using the “Capture” tab at the top of the user interface to make many of the 
adjustments to Snagit that follow. Snagit version 11 differs from version 10 pictured and uses 
the term “Share” instead of “Output”.   
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Input 

 

 

Since you will be dealing with microfilm images that may display with other adjacent images, 
we recommend setting the Snagit input setting to “Region” or “All in One”. This will allow you 
to press the capture key (default capture key is Printscreen, but you can choose many others 
under “Tools > Program Preferences > Hot Keys”) and quickly drag a box around the exact 
image or area you wish to capture.  
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Optional Multi-Input Function 

 

If you want to capture multiple portions of an on-screen image and want them combined on your 
print and/or image file, you can check the “Multiple Area” option. This will allow you to drag 
multiple boxes around areas and when you are done, a right click of the mouse will combine. 
This option will not be utilized by most users but it is there if you decide to use it. 

The multi-input function is an ideal mode to use for genealogists and researchers who may not 
necessarily need and entire page but wish to capture a heading, article, picture and other 
information from the displayed image and compile on one page for printing or saving as a digital 
file. Once the capture key is activated, the image is frozen on screen until you complete then 
multiple captures by left clicking your mouse to end the mode. Keep in mind that all image 
elements you wish to capture in this mode most be viewable on the monitor as the scroll function 
will not work in this capture mode and the image cannot be moved until capture is complete. 
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Output ( “Share” on version 11 and higher)  

 

Some users will only need a printout of the microfilm image. In this case you would choose the 
“Printer” as the output device. If you would like the images captured saved to a file, you can 
choose “File” so that the moment you drag a box around the image and release the mouse button, 
the image will drop into the designated folder as an image file. 

Snagit allows for “Multiple Outputs” so you can send the image to a file and print it 
simultaneously. If you prefer this option, check the “Multiple Outputs” and choose the various 
desired outputs. You will be able to configure the settings for each output later.  

If you check the “Preview in Editor” option it will open the editor after each capture so that you 
can annotate or make adjustments to the image. This is not an option that most microfilm 
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users will need as you want a fast and efficient capture  and print of what you see on the 
screen without the need to make adjustments. We recommend un-checking the 
preview in editor after selecting at least one output type. 

If your Micro-Image Capture is adjusted properly, you will get an exact copy of the image you 
see onscreen spooling to your printer or saving to a file folder within a second or two. 

Output Properties 

 

At the top of the user interface, click on Capture tab, then mouse over Output (Share in V11) and 
finally click on “Properties”. Here you will configure the output properties for each output 
chosen. The first tab here is the Image File tab where you will choose what format image you 
prefer, if you want the program to prompt you for a file name prior to saving or if you want the 
images automatically named with the prefix of your choice like “Microfilm.0000.pdf”. Here you 
will also designate the destination folder that will receive all of your captured images.  

Keep in mind that choosing “ask for a filename” will prompt you after every capture, so if you 
do not need to index your images at the time of capture, it is much faster to choose the 
“Automatic File Name” option.         
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If you are saving captured images… 

The PDF format is the best, so select “Always use this file format”, and then select “PDF”. Now 
click “Options” to scale the PDF image so that whatever you capture on screen completely fills 
the PDF selected document size. 

If you are printing captured images… 

You will need to go to the “Print” tab and select your designated printer. All printers on your 
PC/network will show up, just choose your preferred printer then you will configure image 
scaling so that even slightly undersized captures will fill the print area of your output document.  
Follow these steps to set up your printer: 

              

1. Select “use these settings”, choose your printer and click the apply button at the bottom.  

2.  Click on “page set up” and select “fixed size” and unselect the “keep aspect ratio” 

3. If you are viewing Portrait documents (11” tall by 8.5” wide), set the width to 8.0 and the 
height to 10.5 

4. If you are viewing Landscape documents  (11” wide by 8.5” tall), set the width to 10.5 
and the height to 8.0)  (If printing ledger or larger engineering drawings configure with 
dimensions that meet your print output requirements) 

5. Click O.K. 

6. Next click on the “Paper” tab and select the appropriate format (orientation), click O.K. 

7. Now click the button next to your printer that says “Printer Properties” and configure 
your printer so that it will by default print the orientation you have selected. Click O.K. 
and exit the output properties.  
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Using the print scaling option will allow you to scale any image captured to meet your 
printer’s capabilities. Scale engineering images to 11x17 minimum and up to C, D or E size 
if available. 

----------------------------------------------------------------------------------------------------------------- 

Select a “Hot Key” to activate your captures… 

 

The Snagit program default hotkey is “Printscreen”. Many computers already use this key to 
activate various functions so we recommend choosing another hotkey such as one of the “F” 
keys on your keyboard. Right handed users may prefer F9 through F12 while left handed users 
may find it easier to use the F1 through F4 keys. 

Setting your Snagit Hotkey 

1. Click “Tools”, then “Program Preferences” in the Snagit Control Panel. 

2. Under the “Hotkeys” tab, select you’re preferred “Global Capture Key” and click apply, 
then O.K. 
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When you would like to capture an image on your monitor, just press the appropriate hotkey to 
activate the capture. You can designate one hot key to print images and another hot key to save, 
or one hot key to both save and print; it is up to your preference based on requirements. 

Effects 

 

If you are using Negative Microfilm and choose to view the images in the Grey Scale or Black 
Line modes, you will need to check the “Invert Colors” option under the “Color Substitution” 
tab so that when your image prints (or is saved), it will be in the “positive mode” which saves 
toner usage and is easier to read.   

If you view your Negative Microfilm in the “Color Inverse” mode, your images will be 
positive on the PC screen and you will not need to select the invert colors option under 
color substitution. 

If your output print or saved image has a grey background, you can remove that automatically by 
selecting the “Color Correction” effect and adjusting the brightness or contrast of the image 
output. You will have to experiment with brightness and contrast settings here, capture sample 
images and continue to adjust until the output meets your requirements. 

Select the “Image Resolution” effect under “Effects” and set it to 600dpi for optimum 
capture and print quality. 
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As you can see, there are a lot of effects available including the watermark which is one that 
some companies can use to show that the output document or image was created by them. 

 

Save your Profile! 

 
Once you have made your selections and adjustments and are satisfied with the result, please 
click on the large green + at the upper right section of the Snagit control panel to save your 
settings and create a profile by name. 

This saves all the adjustments you have made and created a profile icon under the “My Profiles” 
area and even lists all the properties of that profile at mouse over. You can make as many 
profiles as needed and they will always appear on the Snagit control panel. 

Be sure to give each profile an a name that reflects its output type like “Image to File” or  “Image 
to Printer” and assign a different Hot-Key for each when saving. This way, if you are looking at 
a microfilm image on the screen and want to immediately send it to the printer, you press the 
selected hotkey for that function, if you want to save to file you press that hotkey so you never 
really need to open the Snagit user interface once these profiles are set up. Snagit is 
automatically active when your PC is turned on and is always ready to capture images when the 
hotkey is depressed. 
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Quality Assurance 

Every Micro-Image Capture unit goes through quality assurance tests including checks for 
proper focus and resolution quality as well as mechanical build and fitment. 

 We use both negative and positive film in low and high magnification ranges to insure the unit 
meets our quality standards prior to packaging for shipment. A print sample from a microfilm 
resolution target capture is included with each unit and contains the unit serial # and the 
calibration settings used to achieve that particular scan/print. 

Every Micro-Image Capture unit comes with a one year manufacturers repair or replace 
warranty. 

 

Safety Precautions 

Observe the following guidelines to ensure that your Micro-Image Capture unit will provide high 
quality performance, operate safely and to prevent defects. 

• Do not use this device in environments outside the following range:  

Temperature: 0°C to 40°C ( 32 to 104 degrees Fahrenheit ) 

Relative humidity: 45% ~ 85%. 

• Do not use this device under: 

– direct sunlight exposure or bright ambient light that falls on the image area 

– very humid and dusty environment; 

– near any kind of heat or vibration sources 

• Do NOT attempt to disassemble or repair your Micro-Image Capture.  Do not open the camera 
housing as this will void the warranty. 

• Protect the device from oil, vapors, steam, moisture, and dust. 

• Please turn off the illumination pad after use to prolong lamp life 

Specifications: 

The Micro-Image Capture is a low energy usage USB powered device. (USB 2.0 recommended) 

System Weight: (Head & Base) is 10 Lbs. / Dimensions: 14”L x 10”W x 7” H 
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Micro-Image Capture Camera Setting Term Definitions 

Auto Exposure 

Exposure Compensation is a feature of a camera that allows you to adjust the exposure measured 
by its light meter. This means that you can adjust the exposure measured by telling the camera to 
allow more light in (positive exposure compensation) or to allow less light in (negative exposure 
compensation). Some microfilm allow too much light to reach the camera sensor, so please take 
note that we recommend that you uncheck the auto exposure box and manually adjust the 
exposure to obtain the very best quality image.  

Brightness - Brightness enables you to adjust the brightness of the displayed image or video to 
suit your own preference. Use the slider to find your preferred setting. Microfilm tends to let a 
lot of light through to the camera, so we recommend the brightness level be turned down below 
the half way mark for most applications. 

Contrast - Contrast enables you to control the ratio between dark and light according to your 
own preference. Use the slider to find your preferred setting. With negative microfilm in 
particular, you should set the contrast between ¾ to full end of the scale. 

Gamma - Gamma enables you to brighten dark areas within the displayed image or video and 
visualize more details without over-exposing already light areas. Use the slider to find your 
preferred setting. 

Saturation 

Saturation enables you to set the color reproduction from black and white to a full color image or 
video according to your own preference. Use the slider to find your preferred setting. We 
recommend saturation be turned completely down to make the image black and white. If color 
displays, turn it up, then down. 

Video Resolution & Shutter Speed  

Increasing video resolution will improve view and print quality but shutter speed at the highest 
resolution will be slower than at the next setting down. Higher shutter speed will reduce lag 
(latent image) when moving the microfilm.  

Micro-Image Capture systems (mechanical, software & methods) were designed and patented by 
Micro-Image Capture, LLC and are distributed by authorized dealers in the U.S. and worldwide. 
Micro-Image Capture™ is a registered trademark of Micro-Image Capture, LLC, a Wyoming 
Corporation  

Brands and product names referred to in this manual are trademarks or registered trademarks of 
their respective companies and used for descriptive and illustrative purposes. 


